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Documenting Hazards Overview 

In this lesson, you will create an ArcGIS QuickCapture project to help field workers document hazards of different types while 

out in the field. You will create and share a simple project for users to locate, categorize and take a photo of hazards with the 

ArcGIS QuickCapture mobile app. 

• Publisher or Administrator role in an ArcGIS organization 

• ArcGIS QuickCapture 

• A smartphone or tablet with Android 5.0 or later or iOS 11 or later 
 
 

 

https://www.esri.com/en-us/arcgis/products/arcgis-quickcapture/overview
https://www.esri.com/en-us/arcgis/products/arcgis-quickcapture/overview
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Create ArcGIS feature service 

In this lesson, you’ll create a new hosted feature layer using a feature layer template from ArcGIS Online. 

https://community.esri.com/community/arcgis-quickcapture/blog/2019/06/26/arcgis-quickcapture-hazards-project-tutorial 

Create layer 

Before you can send your field crew to document hazards in the field, you need to create a hazards layer for them to edit from. 

1. Sign in to your ArcGIS organizational account by going to arcgis.com and logging in with credentials provided by your 
organization. 

 
2. At the top of your organization home page, click Content. 

 

 
 

The content page stores all the layers, maps and apps that you own in your ArcGIS Online organization. This is where 

you’ll create your Hazard feature service. 

3. Under the content ribbon, click Create and choose Feature Layer. 

 

 
The Create a feature layer dialog appears. This is where you can select from a variety of feature layer templates. These are 
hosted layers with pre-defined schema and symbology. They’re empty and editable. So, you can get people into the field 
faster! 

4. In the Search box, type Hazards and select the Hazards feature layer template that appears. 

 

  
 

The Hazards side panel appears, with some additional information on the feature layer template. 

5. Click the Create button. In the next dialogue, click Next and then click Next again. 
 

 

https://community.esri.com/community/arcgis-quickcapture/blog/2019/06/26/arcgis-quickcapture-hazards-project-tutorial
https://www.arcgis.com/home/signin.html
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The final dialogue appears, where you’ll specify a title, tags, and summary for your new hosted layer. 

6. For the title, type Hazards_yourinitials. 

7. The tags should already have, Hazards, Threats, Safety, Violence. 

8. For the summary, type feature service to collect locations of hazards. 

 
 

9. Click Done, once you’ve entered information about your layer 

The item details page for your new feature service will open. This is where you can access information and update settings 
for your feature service. 

 

Configure feature service 

Next, you'll get the feature service ready for the field by adding additional features. Then, you’ll enable editing. 

Make sure you are still on the item details page of your new feature service. Click on the Data tab. 

This gives you a table view of fields currently in your feature layer. These fields will store information about documented 
hazards. Next, you’ll add new fields that will automatically populate in the ArcGIS QuickCapture mobile app. 

1. Above the table view to the right, click Fields. 

 

A detailed view of the fields opens. This is where you can access additional information about your fields and add new 
ones. 

2. On the top left of the page, click the Add button.  
The Add Field dialogue opens, next you’ll add information for a new field 

3. For Field Name, type HA. 

4. For Display Name, type Horizontal Accuracy. 
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5. For Type, select Double. 

6. Click Add New Field to close the dialogue. 

 

You’ve just added a new field to store the horizontal accuracy of hazards when documenting them in the field. Next, you’ll 
add another field to store time information. 

 

7. Click the Add button. 

8. For Field Name, type TimeCaptured. 

9.  For Display Name, type Time Captured.  

10.  For Type, select Date. 

11. Click Add New Field to close the dialogue. 

You’ve just added a new field to store the exact time when an observation is made in the field. Next, you’ll apply settings to 
the hazards feature service that will enable editing capabilities. 

12.  Click the Settings tab, at the top right of the page. 

13.  Make sure edit settings reflect the screenshot below: 

 

 Before creating the QuickCapture Project, you’ll look at your new feature service in the Map Viewer. 
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14.  Click on the Overview tab. 

15.  Click Open in Map Viewer. 

This will load your empty feature service into the Map Viewer. 

16.  Click on the Legend to display the predefined categories in your layer. 

 

Next, you’ll save the map so you can return to it at the end of the lesson to view results. 

17.  Click Save. 

18.  For the title, type Hazards map_your initials 

19. For the tags, add Hazards 

20. For the summary, type A map of Hazards captured in the field. 

 You have just completed the configuration of an empty feature service to document hazards while in the field. Next, you’ll 
learn how to configure an ArcGIS QuickCapture project. 
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Configuring ArcGIS QuickCapture Project  

Now that you've configured the hazard feature service, you'll use it to configure a project using QuickCapture designer. 

1. Navigate to https://quickcapture.arcgis.com and login with your ArcGIS credentials. 

2. Click the New Projects button. 

3. Select the new feature layer you just created and click Next. 

Before you can create your project, you’ll add basic information like a title, tags and a data-recover email.  

 
4. For the title, type Hazards. 

5. For the data recovery email, type your email address. 

6. Click Create. 

Your hazard feature service gets loaded into the ArcGIS QuickCapture designer. By default, a button gets created for each 
hazard type. Next, you’ll change some of the characteristics of your buttons as well as their data behavior.   
 

7. Click on the Hazard group name. 

 

The group properties open in the right side panel.  

8. Change the Number of columns to 2. 

9. Click the Road Not Passable button. 

10.  On the right-side panel, click the Data section. 

11.  To the right of Take photo toggle the button to enable photo capture. 

 

 

 

https://quickcapture.arcgis.com/
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Remember the fields you added? Horizontal Accuracy and Time Captured. Before you complete the project you’ll set these 
variables for each hazard type. 

12.  Make sure the Road Not Passable button is still selected and the Data section is open in the side panel. 

13.  Under Horizontal Accuracy, for value type select Device variable and select Horizontal Accuracy (m). 

14. Under Time Captured, for value type select Device variable and select Capture time (UTC). 

 Note: If you do not see the fields, scroll down in the right-side panel to see full list of captured fields. 

 

15.  Complete the same process for the remaining 7 hazard types. Enable photo capture (optional) and set the values for 
Horizontal Accuracy and Capture Time. 

16.  Click Save at the top right of your screen. 

You have just completed the configuration of your first QuickCapture project. You can make additional changes with ArcGIS 
QuickCapture designer at any time. 
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Sharing your ArcGIS QuickCapture project 
All ArcGIS QuickCapture projects are stored in your Content page within your ArcGIS Organization as a dedicated ArcGIS 
item type (the ArcGIS QuickCapture project item type). Next, you’ll share your new Hazards QuickCapture project so it can 
be used by people in the field. 

 

1. In a new tab in your browser, return to https://www.arcgis.com and ensure you are still signed in with your ArcGIS 
Online credentials. 

2. At the top of the page, click Content. 

3. Select your hazards Feature Layer and hazards QuickCapture Project. 

4. Click, share and under set sharing level select Organization. 

 
 

Document hazards 

Previously, you created and then shared a QuickCapture project. Next, you'll use the ArcGIS QuickCapture to document 

Hazards in the field. 

(If you haven’t already) Download ArcGIS QuickCapture 

First, you'll download ArcGIS QuickCapture as a free app on your smartphone or tablet. QuickCapture allows you to 

remotely capture features. Because it can be accessed from a mobile device, field workers can input information on 

hazards directly into your GIS, eliminating pen and paper from the process. 

1. On your smartphone or tablet, find ArcGIS QuickQuickCapture on Google Play or the Apple App Store (for iPad and 

iPhone). 

 Note: Your experience may differ depending on whether you use the Android or iOS. 

The steps and images here are for QuickCapture on an iPhone. 

2. Download and install the free app. 

 

Open the project 

Next, you'll open the Hazards project in ArcGIS QuickCapture. 

1. Open ArcGIS QuickCapture on your mobile phone or tablet. 

2. If you aren't signed in, sign in to your ArcGIS organizational account. 

After you sign in, the app opens to My Workspace. If you’ve used ArcGIS QuickCapture before, this is where you will see 

already downloaded projects. You probably don’t see your Hazards project because you have not downloaded it to your 

device yet. Next, you’ll download and open your project. 

3. At the bottom right of your screen click the plus button and select Browse Projects 

4. Tap the download icon next to your Hazards project. 

The Hazards project will be downloaded to your device. Once the download is finished you can begin capturing Hazard 
locations. 

5. Tap the x in the top left to return to My Workspace 

 

https://www.arcgis.com/
https://play.google.com/store/apps/details?id=com.esri.arcgisquickcapture&hl=en_US
https://apps.apple.com/us/app/arcgis-quickcapture/id1451433781
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You should see your downloaded Hazards project listed. 

6. Tap on the Hazard graphic to open the project. 

You can see all of the Hazard types listed. These are all interactive buttons.  

7. Explore the project by selecting different Hazard buttons.  

When you select a button, the location, hazard type, horizontal accuracy, and time captured is all logged and sent back to 
the feature service where it is stored. 

 

View Results 

You just documented the location of Hazards in the field with the ArcGIS QuickCapture mobile app. Now, you’ll use the web 
map you created at the beginning of the lesson to view the results. 

1. Return to your Content page. 

2. Open the map titled Hazards Map_yourinitials. 

The map opens. If you do not see hazards on the map, try doing a location search for your current location. 

3. Click on one of the Hazards on the map to get it’s pop-up information. 

 

 
In this lesson, you enabled a hazard documentation process from a paper form to a digital one. First, you created and 

configured a feature service using a template in your ArcGIS Online organization. Then, you built an ArcGIS QuickCapture 

project around the feature service and ArcGIS QuickCapture mobile app to gather hazard locations in the field. The hazards 

you added was automatically updated to the feature service.  

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

 

http://learn.arcgis.com/en/gallery/
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Reporting Water Violations Overview 
 
This exercise should take 20 – 30 minutes and will guide you through the creation of a survey form using the 
Survey123 website’s Web Designer.  We will be creating a simple form to report a city code violation. To do this 
exercise, you will need: 

• Publisher or Administrator role in an ArcGIS organization (get a free trial) 

• A mobile device or tablet with the Survey123 mobile app installed 
 
 

 

https://www.esri.com/en-us/arcgis/trial
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Create a survey 
1. In a new web browser tab, navigate to: https://survey123.arcgis.com 

2. Sign into Survey123 with your ArcGIS Online organization account (if not already) 

3. On the Survey gallery page, click Create New Survey > Using the web designer (Get Started) 
 

 

4. In the Create New Survey dialog that appears, provide a title, tags, and summary – you can optionally add a 
custom thumbnail 

for a title, “Water Waste Report” 

for tags, “water” and “survey123” 

5. Click Create 
 
The survey creation process may take a minute or so because behind the scenes, a new form item and associated 
feature layer are being created in ArcGIS Online. When the survey is made, you will see the survey design page and it 
should appear blank. 
 

 

https://survey123.arcgis.com/
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On the left side of the design page is the survey layout preview, on the right side are the options available to you to 
author your survey. There are 4 tabs in the right configuration panel (from left to right): 

• Add – select the type of question you want to add to the survey; 

• Edit –  edit the properties of a survey question; 

• Theme – defines the appearance of your survey; 

• Settings – enables you to configure a ‘thank you’ message after the survey is submitted. 
 
 

Adding Questions 
You will create as Water Waste Violation report with 8 questions.  
 

1. From the Add tab, select the Date question and drag it onto your survey layout on the left. 
 

Notice that the survey question now appears on the survey layout. By default, it is untitled. You can configure the 
properties for the question under the Edit tab. 

 

2. Select the date question on the survey layout, then select the Edit tab. 
 

 
 

3. On the Edit tab, for the Label input, type “Violation Observation Date:”  
 

Observe that as you input the label, the information is reflected on the survey layout. Many different parameters 
can be configured for each survey question, depending on the type of question. In this case, you can further 
control the default dates and validation rules. 

 

4. On the Edit tab, under Default Value, select the Submitting date option and under Validation, check the This is 
a required question checkbox.  

 

5. To add another survey question, return to the Add tab. Select the Dropdown question and drag it into the 
survey below the Date question. 
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6.  This will hold the type of water violation, so label it “Type of Violation:”.   
 

The Dropdown allows the person to fill in the form by selecting one of several values. On the Edit tab, just above 
the list of choices, there is a link called ‘Batch Edit’. This allows you to put the choices in one after another and is 
useful when you have lots of choices.  

 

 
 

7. Click on the Batch Edit link and input the following choices (note you can copy/paste from this doc directly into 
Survey123): 

Overwatering 
Broken sprinkler 
Time-of-day violation 
Assigned day violation 
Fountain/Water feature violation 
Broken pipe or leak 
Misting system violation 
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8. After entering the choices, click OK. The entries will now appear in the choices section: 
 

 
 

9. Next, we want to give the respondent a field to provide more details on the violation. For this, we’ll use a 
Multiline text input and create a question called “Notes”.  Both the multi-line and single-line text inputs provide 
a free form text area; while this may make the analysis of the survey data more difficult (due to variations in 
phrasing and terminology), it is helpful to record specifics that we do not know beforehand.  

 

10. From the Add tab, select the GeoPoint question and drag it onto your survey layout. Ensure that you position it 
underneath the Dropdown question you just added.  

11. Activate the Edit tab, for Label type: “Location” 

12. Define the default spatial extent of the map by clicking it and navigate to your current location. 

13. Make the question Required 

14. Let’s save our progress by clicking the Save Button at the bottom of the right side.   
 

Saving is useful if you are planning to make several changes and want to ensure you preserve the existing design. 
 
Survey123 forms support using a smartphone’s camera to take pictures that accompany the form; in ArcGIS, these 
are stored as geodatabase attachments. 
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15. Add an Image question and label it “Photo of Violation”. 
 
The next section concerns who committed the violation.  

16. Add a Single Choice question. Label it as Is the offender present?  and set its choices to Yes and No 

17. Add a Group into the form and set its label to Offender details. 

18. Add the following questions within the group: 
A singleline text question for the Name. 
An email question for their Contact e-mail. 
A signature question for their Signature. 

 

19. Select the “Is the offender present?” question and click on three-pronged arrow in the lower right of the 
question box. This will let us set a rule based on the answer to this question. 

20. In the box that appears, set up the following rule: 
If “Yes”, Show “Offender details”, then click OK. 

 

21. We’ve completed the form. Save it again. 

 

Publish & Share a Survey 
 
Before publishing the form, let’s preview it. 
 

1. At the bottom of the right configuration pane, click the ‘Preview’ Button. 
 
You can preview how the form will look in a desktop monitor, tablet or a phone-sized screen. The form should have 8 
questions. 
 

2. Once done previewing, click on the “X” button to close the preview. 

3. To publish the survey, click the “Publish” button at the lower right; dismiss the message dialog by clicking OK. 

4. Click Publish at the lower right. 
 

 
 
The process may take a minute, you will see a “Publish Successfully” message window appear when it’s done. 
 

5. After publishing, click on the “Collaborate” tab.  
 
In this dialog, you can share the survey to specific groups, the organization, or everyone; this will determine who can 
submit data to the form.  You can also get URL links and barcodes to help end users open your survey. 
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6. While keeping the Open the survey in browser directly option selected, copy the survey link and paste it into a 
new browser tab. The survey will open. Complete and submit a survey from your web browser. 

 

 
 

7. Switch the link option to Open the survey in the Survey123 field app directly and copy the link again. Open the 
link from your mobile device and submit data using the Survey123 mobile app. 

 

 
 
 

8. Switch to the Data tab to explore records submitted to your survey. 
Explore filtering options 
Explore export options 
Click on the records in the table to open the Individual Response report 

9. Switch to the Analyze tab to understand trends in the data submitted to your survey. 

 
In this lesson, you created a Survey to report water violations using the Survey123 for ArcGIS Web Designer. The Survey is 

accessible via web browser and mobile app. You then analyzed the results which are updated in near real-time. 

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

http://learn.arcgis.com/en/gallery/
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Inspect Hydrants Overview 

Naperville, Illinois, is converting its fire hydrant inspection reports from paper to tablets. In this lesson, as a GIS manager in this 

Chicago suburb, you'll work with inspection data in ArcGIS Online in the form of a web map you can share directly with your 

workers. While your inspectors are on location, they'll update their hydrant reports directly to the map. 

• Publisher or Administrator role in an ArcGIS organization 

• Collector for ArcGIS 

• A smartphone or tablet with Android 4.2 or later or iOS 11 or later 

https://www.esri.com/en-us/arcgis/products/collector-for-arcgis/overview
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Create a map for inspections 

In this lesson, you’ll add an existing ‘hydrants’ layer to a web map in your ArcGIS Online Organization. Then, you'll configure 

the layer's pop-up to show inspections in chronological order. Finally, you'll share your layer and map so your workers can 

access them. 

Add the layer to a map 

Before you can send your field crew to inspect hydrants, you need to add your hydrants layer to a web map. 

1. Sign in to your ArcGIS organizational account by going to arcgis.com and logging in with credentials provided by your 
organization. 

 
2. At the top of your organization home page, click Map. 

 

 
A new map opens. The map extent for a new map is set to the default extent of your organization. Next, you'll search for 

and add a hydrants layer. 

 Note: If you're in a new ArcGIS Online session, clicking Map opens a new map. Otherwise, it 

opens the last map you were using. If an existing map opens, click New Map in the 

upper right corner of the page and choose Create New Map. 

3. On the ribbon, click Add and choose Search for Layers. 

 

 
The Search for Layers pane appears. 

4. In the Search pane, click the My Content drop-down arrow and choose ArcGIS Online. 

5. In the Search for layers dialog box, type Hydrants_Workshop2020. Press Enter to initiate the search. 

 

 
 

The search returns the Hydrants_Workshop2020 layer. This layer contains point features that will display the location of 

each hydrant. 

https://www.arcgis.com/home/signin.html
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6. For the Hydrants_Workshop2020 layer, click the + Add button. 
 

 
 Note: Your default extent may differ from the example depending on your monitor size and 

resolution.
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In the Contents pane are four items: the Hydrants_Workshop2020 layer; the Topographic basemap; and the Inspections and 

Violations tables. Their layer names are a little confusing, however. You'll change them to something more readable before 

continuing. 

7. Point to the Hydrants_Workshop2020 layer. Click More Options and choose Rename. 

 

 
8. Rename the layer Hydrants and click OK. 

9. Rename the Hydrants Workshop - Inspections table to Inspections. Rename the Hydrants Workshop - Violations 

table to Violations. 

 

Configure the layer's pop-up 

Next, you'll configure the pop-up of the Hydrants layer to show data from the Inspections table. You'll adjust the pop-up's sort 

options so inspections appear in chronological order. 

1. Zoom in on the map so that individual hydrant features become distinguishable. Click any hydrant to view its pop-up. 

 

 
The pop-up shows the attribute information of the Hydrants layer. The formatting is good enough, but there is some 

information your workforce won't need to see. You also want to make sure you can access related inspections for each 

hydrant through the pop-up, although currently those tables don't have any records (you'll add records in the next lesson). 

2. Close the pop-up. 

3. In the Contents pane, point to the Hydrants layer. Click the More Options button and choose Configure Pop-up. 

4. For Pop-up Title, type Facility ID: (including the trailing space) before the field value to give it context. 
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5. In the Pop-up Contents section, below the list of field attributes, click Configure Attributes. 

6. In the Configure Attributes window, in the Display column, uncheck OBJECTID and GlobalID and click OK. 

 

 
At the bottom of the Configure Pop-up pane are options for showing related data. Show related data is checked by 

default. There are also options for how related data is sorted. 

7. In the Related Data section, click Sort Options. 

 

 
The Sort Options window opens. You'll sort the inspections data chronologically. 

8. For Field, choose Inspection Date. For Order, choose Ascending. 

 

 
9. Click OK in the Sort Options window. At the bottom of the Configure Pop-up pane, click OK. 

10. Click any hydrant to view its updated pop-up. 
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Save and share the map 

Now that you've created the map, you'll save and share it. To ensure you share it only with your field workforce, you'll create a 

group to which you can invite specific members. 

1. On the ribbon above the map, click Save and choose Save As. 

 

 
2. For the title, type Hydrant Inspections and Violations. 

3. For the tags, add hydrants, inspections, violations, Naperville, and Illinois. 

4. For the summary, type A map of fire hydrants and hydrant inspection information in Naperville, 

Illinois. 

 

 

5. Click Save Map. 

The name change is reflected on the map. Now that your map is saved, you'll share it with your workforce. First, you'll exit 

the map and create a group. Groups allow you to choose who sees the group's content, so you can ensure only your 

workforce has access to the information. 

6. At the top of the map, click the Home menu and choose Groups. 
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The Groups page opens, which shows the groups (if any) of which you are a member. 

7. Click Create group.  

 

 
A new page opens, allowing you to set the parameters of your group. 

8. Name your group Naperville Hydrant Inspectors. For the summary, type Content for hydrant inspectors 

in Naperville, Illinois. Add search tags that describe the group's content and geography, like the ones you used 

for the map. 

 

 
    Tip: You can drag or upload a thumbnail image. Good ideas for thumbnails are logos or 

crests of the town or department with which the group is associated. You probably 

don't have the Naperville city crest, so you can leave the thumbnail blank. 

9. For Who can view this group, click Only group members. 
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By making your group private, only users you invite can join and view the group's content. Accept the default for the 

remaining questions. 

10. At the bottom of the page, click Create Group. 

The group is created. It has no items and no members other than you. If you want to invite members to the group, click 

Invite Users at the top of the page. 
 

    Tip: If using ArcGIS Online, you can invite members both inside and outside of your 

ArcGIS Online organization. As long as your field inspectors have ArcGIS Online 

accounts, you can invite them to your group. 

Next, you'll share your web map with the members of the group. 

11. At the top of the page, click Content. 

12. Check the Hydrant Inspections and Violations web map. Click Share. 

 

 
13. In the Share window, check the Naperville Hydrant Inspectors group. 

 

 
14. Click OK. 

15. On the ribbon at the top of the page, click Groups. Click your Naperville Hydrant Inspectors group. 

The web map and Hydrants layer are now accessible through the group. 

 
You've created a web map to collect inspection records and shared the map with your field workforce. 
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Inspect a hydrant 

Previously, you created a map to collect hydrant inspection information. Next, you'll use Collector for ArcGIS to test how your 

map functions in the field by adding an inspection and a violation to a hydrant feature. 

(If you haven’t already) Download Collector for ArcGIS 

First, you'll download Collector for ArcGIS as a free app on your smartphone or tablet. Collector allows you to remotely edit 

data in a shared map. Because it can be accessed from a mobile device, field workers can input the results of their on-site 

inspections directly into your GIS, eliminating pen and paper from the process. 

1. On your smartphone or tablet, find Collector for ArcGIS on Google Play or the Amazon Appstore (for Android devices), the 

App Store (for iPad and iPhone), or the Microsoft Store (for Windows 10 devices). 

 Note: Your experience may differ depending on whether you use the Android, iOS, or 

Windows version of Collector. The steps and images here are for Collector on an 

iPhone. 

2. Download and install the free app. 

 
Open the map in Collector 

Next, you'll open the Hydrant Inspections and Violations map in Collector. 

1. Open Collector for ArcGIS on your mobile phone or tablet. 

2. If you aren't signed in, sign in to your ArcGIS organizational account. 

After you sign in, a list of your maps opens. If you have only a few maps, the Hydrant Inspections and Violations map may 

be easy to locate in the list. If you have many maps, it may be more difficult. In case the map is not easy to locate, you'll 

access the map through the Naperville Hydrant Inspectors group. 

3. Scroll to the bottom of the list of maps to see your groups. 

Note: For Android users, tap the Menu button to view your groups. 

https://play.google.com/store/apps/details?id=com.esri.arcgis.collector
https://www.amazon.com/esri-inc-collector-for-arcgis/dp/b00x8t73be
http://links.esri.com/collector-aurora-appstore
http://links.esri.com/collector-aurora-appstore
https://www.microsoft.com/en-us/p/collector-for-arcgis/9wzdncrdg7lk?rtc=1&activetab=pivot%3Aoverviewtab
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4. Tap Naperville Hydrant Inspectors. 

A list of maps in that group opens. Only the Hydrant Inspections and Violations map is in the group, so it is the only map 

listed. 

 

 
5. Tap the map to open it. 

If you have location services turned on, the map opens to your current location, regardless of the map content. You're 

probably not in Naperville, so you'll navigate there. 

6. Tap the Search button. 

7. Type Naperville in the search bar and tap Search. 
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Naperville, Illinois, is the first search result. 

8. Tap the result for Naperville to zoom to the center of the city. 

 

 
9. In the panel at the bottom of the map, tap the close button to close the search results and tap Cancel in the search panel to 

close it. 
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Add an inspection to a hydrant 

Now that you've opened your map and navigated to Naperville, you'll perform a mock inspection of a hydrant. 

1. Tap any hydrant on the map. 

The tapped hydrant is selected on the map. A panel opens, showing information about the hydrant. 
 

Note: For Android users, tap a hydrant once to select it, then tap the pop-up to expand it. 

 

 

2. Scroll the panel to view more of the hydrant's details. 



Inspect Hydrants 

Copyright © 1995-2019 Esri. All rights reserved. 16 

 

 

 
 

 

 
 

The details include the information in the feature's attributes and actions you can take with the feature. Below the attribute 

information and before the actions is a section titled Related that includes inspections. For Android users, under the 

Inspections section, you will see options to View an inspection or to add a New inspection. 

3. Tap Inspections to view existing related inspection records or create new ones. 

 

 
The panel shows a button to add an inspection as well as a list of inspections related to the hydrant you've tapped. Since 

there aren't any inspections yet, none are listed. 

4. Tap Add. 

 Note: For Android users, under Inspections, tap New. 

The Inspections form opens. It contains the fields in the Inspections table. Swipe up to view the form full screen. 
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5. Tap the Pressure (PSI) field. 

The field becomes editable. 

6. Enter a value of 60 (a standard PSI value for fire hydrants) and tap Next. 

7. Add data to the other fields. (You may have to scroll down to see some of the fields, including Inspection Date.) 

 



Inspect Hydrants 

Copyright © 1995-2019 Esri. All rights reserved. 18 

 

 

 
 

 
This is a test, so the values you add aren't important. Most fields require only a yes or no. When you add an inspection 

date, the title of the form changes to include it. 

8. Tap Submit to send the updates. 

 Note: For Android users, tap the checkmark button to save your inspection and return to the 

hydrant's details. 

You return to the map. The hydrant feature is still selected and the new inspection form is displayed. 

9. Close the inspection form, and close the Inspections panel to see the hydrant's details again. Scroll down to the Related 

section and tap Inspections to view the inspections on the hydrant. 

 Note: For Android users, under Inspections, tap View. 

The inspection appears as part of a list, marked by its date. If you add more inspections, they will be organized 

chronologically. 



Inspect Hydrants 

Copyright © 1995-2019 Esri. All rights reserved. 19 

 

 

 
 

 

 
 

Add a violation to your inspection 

You published your hydrants layer to also include a table for violations observed during inspections. The Violations table does 

not have a direct relationship to the Hydrants layer, but it is indirectly related to it through the Inspections table. Next, you'll add 

a test violation to the hydrant. 

1. On the list of the hydrant's inspections, tap the inspection you just added. 

 

 
The inspection's form and available actions display in the panel. All of the values you inputted for the inspection are shown. 

Below the attribute information and before the actions is a section titled Related that includes violations. For Android users, 

the section is titled Violations. 

2. Tap Violations to view existing related violation records or create new ones. 

 Note: For Android users, under Violations, you can select View to see all existing records 

or select New to add a new record. 
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The panel shows a button to add a violation as well as a list of violations related to the inspection you've tapped. Since 

there aren't any violations yet, none are listed. 

3. Tap Add. 

 Note: For Android users, tap New. 

A form containing the fields in the Violations table opens. 

4. Fill out the four fields (it doesn't matter what you enter). 

 

 
5. Tap Submit. 

 Note: For Android users, tap the checkmark button to submit the violation. Then, tap View 

to review the submission. 

You see the new violation as well as information about the inspection and hydrant to which it is related. 

 
In this lesson, you enabled a fire hydrant inspection process from a paper form to a digital one. First, you create a web map in 

your ArcGIS Online organization. Then, you opened the web map in Collector for ArcGIS and added a test inspection and 

violation. The inspection you added was automatically updated to the web map. You can access the data through both 

Collector and the original web map in your ArcGIS organization. 

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

http://learn.arcgis.com/en/gallery/
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Fire Response: Real-time and Analysis 

Fire Response: Real-time and Analysis Overview 

Real-time data is useful for operations during fire, rescue and EMS incidents.  This data includes not only dispatch and field 

data, but also data from external sources such as traffic conditions.  Later, analysis of historic data can yield valuable 

insights for making improvements.  For both purposes, dashboards can be great aids with through visualizations using maps, 

charts, gauges, lists, and key performance indicators. 

Exercise requirements: 

• Publisher or Administrator role in an ArcGIS organization (get a free trial)

• Operations Dashboard for ArcGIS

https://www.esri.com/en-us/arcgis/trial
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Fire Response: Real-time and Analysis

Complete a real-time web map 

The first step to creating your real-time apps is to make a web map with the necessary real-time data.  You will start with a 

partially configured web map and familiarize yourself with the content which comes from many organizations.  Then you will 

explore and add a further layer.  The goal of this section is to understand what functionality of the dashboard is actually set in 

the web map that it references. 

Open and examine a prepared Web Map with Traffic and Fire information 

1. Sign in to your ArcGIS organizational account.

 Note: If you don't have an organizational account, you can sign up for an ArcGIS free trial. 

2. At the top of your organization home page, click the Magnifying Glass icon.

In the search box, type in Honolulu Workshop 2020 and click enter. 

3. Turn off the filter restricting results to your own organization by sliding the circle to the left

4. For the Honolulu Workshop 2020 Web Map, click on the ellipsis in the lower right corner, and choose Open in Map Viewer
from the menu.

https://www.arcgis.com/home/signin.html
http://links.esri.com/arcgis-free-trial/
http://links.esri.com/arcgis-free-trial/
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5. To see the legend of pre-loaded data layers, you may need to click on the Legend button on the left side.

• Fire Stations reference the State of Hawaii’s
Geoportal.  The station number is labeled on the
map.

• Incidents are from the National Fire Incident
Reporting System for July 2019.  Three different
categories are represented by color and shape,
and the larger the size, the longer the response
time between the alarm and arrival at the scene.
Data comes from both centralized operations
like dispatch, but also information that is
collected in the field during and, if investigation
is called for, after the incident.

• Only a subset of City and State Traffic Cameras
are shown.

6. Switch to the Content and uncheck the boxes for Fire Stations and Incidents to turn off their visibility.

7. Click on a camera and note the time stamped into the Go Akamai photo.  These images are update approximately every two
to four minutes.  The traffic camera pop-up is configured to refresh every minute, meaning that it will check for updates every
minute.
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Explore and add real-time traffic data 

1. Click the Add button and choose Browse Living Atlas Layers, which are content curated by Esri that is
available to ArcGIS Online users.

2. Type in live traffic and press Enter.

3. Click + button for the World Traffic Service.

4. Click the left-pointing arrow to return to the contents.

As you might expect, the red lines indicate congestion and the green indicate that traffic is moving close to its design 

speed. 
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 Note: Data refresh is managed in the Web Map, not in the Operations Dashboard. 

5. Check the default refresh setting by clicking the ellipsis and hovering over the Refresh Interval menu option.

 Note: Bookmarks are also managed in the Web Map. 

6. (Optional) If you switch between the Honolulu Urban Core and Oahu bookmarks, you will see differences in the content

detail provided by the traffic service.

7. Click Save (Save As), replace the word Copy with your initials, and click the Save Map button.
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Fire Response: Real-time and Analysis 

Create a dashboard 

For real-time operations, fire and EMS officials would want to have a handle on traffic conditions.  In reality, operations have 

significantly more data than you have been provided in this exercise including AVL (automated vehicle location) feeds and dispatch 

information.  Potentially Tracker could be provided for all personnel such that real-time decisions would be even better informed.  

Analysts also want to mine historic data to evaluate past performance and identify recommendations for improvement.  For 

example, response time might vary by fire station.  Visualizing the distribution of incidents served by each station might help explain 

these statistics. 

In this exercise, you will create a type of dashboard using Operations Dashboard for ArcGIS which is included in your ArcGIS 

Online subscription without any additional fee and can be shared freely, depending on your organization’s governance policies. 

In addition to the dynamic map element that references the web map you completed in the last step, you will add the following 

elements:  

• A list of the most recent incidents with information on the incident type, text of the location, and time that the call was received.

• A gauge showing response time.

• A chart of fire stations with the number of incidents each handled during the historic time frame.

You will also configure actions that will allow user interaction with each element to update the content of the other elements. 

Use your web map as the base for an operations dashboard 

There are several ways to initiate an operations dashboard, but since you are already in the web map that you wish to include, 
the following in the most direct approach. 

1. Choose the Share button above the map pane.

 Note: Typically, you would use this button to decide who to share your map with, specifically which ArcGIS Online 

Group(s), your entire organization or the public.  Your organization should have set policies and assigned user privileges. 
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2. At the bottom of the share screen, click on the of share form click on Create a Web App.

3. Click the Operations Dashboard tab.

4. Change the title text from Web Map to Dashboard and click the Done button.

Your new Operations Dashboard app has opened in edit mode with a map element already created reflecting the saved state 
of you web map.  It is possible to save changes to your web map, and they will be applied to your dashboard the next time 
that it is edited (by you) or viewed by anyone who you have shared it with. 
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Configure the dashboard style and add widgets to your map 

1. In the upper right, click the button with the ellipsis and downward-pointing triangle.

 Note: If this were an actual product that you wanted to share, you could click on the right-side icon to copy the Share 

Link to your computer’s clipboard.  This URL link is a shortcut to your dashboard application.  

2. Click on the Dark button to set the theme as shown above.

 Note: There are many more ways to style your dashboard, we invite you to explore at your own time after this workshop. 

3. Click the ellipsis with the triangle button again to close the panel.

4. In the upper right corner above the map, hover your mouse over the blue rectangle and choose the option with the gear icon.
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5. Pop-ups are already enabled.  By sliding the button to the right, turn on visibility of the remaining map widgets except for the
legend.  Then click the Done button.

This will return you back to the map, where you will notice that there are icons for several of these widgets in the upper right 
corner.   

6. Click on the stack of layers and turn on Fire Stations and Incidents.  You can optionally turn off the traffic layers.
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Create and Configure a List for Incidents 

1. On the upper right above the map, click on the plus sign with downward-pointing triangle to create a new element.  In this
case choose List.

2. Click Incidents to set it up as the map layer to use for the list.

3. On the configuration Data tab, click + Sort button.
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4. Specify Alarm Date and Time as the Sort field and switch to Descending order.

5. Click the List tab on the left side.

The Line Item Text is where you specify what information to display.  Any text that you enter will be show up exactly as you 
typed it for each feature except text in curly brackets which fetch the attribute values for the field names within the brackets.  
This typically differs from the content of the pop-up that is configured in the web map. 

6. Within the Line Item Text box, enter the following text:

{IncidentType} 
{ShortLabel}  
Alarm: {AlarmDateandTime} 

The center of the screen provides the actual features, so you will know whether you have made any typographical errors.  
Only the text “Alarm:” will be repeated for each feature.  The values of three fields will be substituted for the rest of the text 
you’ve entered.   

• Incident type is description of the incident that was drawn from a list of 245 codes.
• Short Label is address without zip code and town name.
• Alarm Date and Time reflects when the call was first received.

7. Click on the General tab on the left side.

The default Name of the element is List (1), but a more descriptive name for elements add clarity, indicating not only what 
type of element it is but also the nature of its content and/or how it is sorted. 
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8. Change the Name to Most Recent Incidents List

9. Click on the Actions tab on the left side.

At this point in time, we can start to configure how we want this List element to interact with the other elements that have 
already been created, namely the Map element. 

10. Click the Add Action button and choose Flash.

11. You then need to Add Target, which can only be Map (1), which was the default name for the original Map element.

12. Similarly, add the two more actions for Map (1): Pan and Show Pop-up.

13. In the lower right corner of the screen click the Done button.
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14. Hovering over the bar in the separating the List and Map elements, drag to the left to narrow the List.

The Most Recent Incident List can now trigger actions in the map, and you can now configure user actions in Map (1) to be 
reflected in the list. 

15. Hovering over the upper right corner of the Map element, choose the Configure option.

16. Choose the Map Actions tab on the top of the pane.

17. Click Add Target and then the Most Recent Incidents List.

18. Test the Dashboard: use the map’s bookmarks to switch between Ewa and the Honolulu Urban Core, noting changes in the
List.

19. Zoom into the map and select items from the Most Recent Incidents List to test the effect on the map.  Note the differences
between the description in the List and the Pop-up.

20. Save your dashboard by clicking on the icon on the upper right above the map.
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Create and Configure a Gauge of Response Time 

In this section, you will create a gauge that shows the average incident response time between when the call is received and the 
first truck arrives at the scene of the incident. 

1. Click the icon to create an element and choose Gauge.

2. Click to select Incidents as the map layer you want to use for the gauge.
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3. Click the down arrow for the Statistic to change from Count to Average.

4. For the Average Statistic, the form has added an entry for Field.  Set it to Response Time (sec).

5. The response time attribute was calculated in seconds, but you should convert it to minutes.  Slide the Value Conversion
to the right and set the Factor to 0.016666667.

6. Keep the gauge’s Minimum value at zero, but change the Maximum to 25.
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7. Click on the Gauge tab on the left side.

8. Change the Style to Meter and the Shape to Half Donut.

Note the changes on the right side. 

9. Scroll down on the left panel and click the + Guide button.

10. Keep the guide From value at 0%, but change the To value to 20%, and click the white Color to set it to green.
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11. Add two more guides, setting the next one From 20%, To 40% and make it yellow.
The last one should be set From 40%, To 100% and red.

12. Click on the General tab on the left side.

13. Setting the Title will allow us to put text above the gauge and Description would be placed below it.  Click on the Edit
button for Title.

14. Type in the following text including the Enter between lines:

Average Response Time
(minutes) 

15. Highlight both lines and click the Center Text icon.



Fire Response: Real-time and Analysis 

Copyright © 1995-2020 Esri. All rights reserved. 21 

16. Highlight the top line and click the downward triangle next to Normal.  Choose Heading 2.

The resulting gauge should look as follows: 

17. Click the Done button at the bottom right corner of the screen.

18. Hover over the blue rectangle at the upper left of the gauge element and choose Drag Item.

19. Drag to the bottom of the List element.  The screen should have a blue box that changes text from Drag to a New Position
to Dock as a Row.

20. Drag the border between the list element and the gauge element down.  The gauge doesn’t need as much room.
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21. A gauge element does not allow user interaction, but the map element can control the gauge.  Open the map’s configuration
dialog again and choose the Map Actions tab.

22. Since you have already created a map action for the Most Recent Incidents List, when you click the Add Target button,
Gauge (1) will be your only option.

23. Click the Done button at the bottom.

24. Test changing map extents to see how the gauge responds.
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Create and Configure a Serial Chart to show the Incident Count by Station 

Fire Stations can be analyzed using several criteria: What was each station’s incident count for July 2019?  What was the 
average response time by station?  What was the actual geographic distribution of incident for each station?  To answer the 
first of these questions, you will be adding a serial chart element of count by station.  The other questions can be answered 
by linking this chart to both the map and the gauge. 

1. Create a Serial Chart element.

2. Select the Incident layer.
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3. Set the Category Field to Fire Station Number, which will require scrolling to the bottom of the field list.

4. Count is the correct statistic, but the stations aren’t sorted.  So, click on the + Sort button.

The default settings are acceptable. 
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5. Click on Category Axis (X-axis) tab on the left side and type in its Title: Station Number.

6. Click on the Value Axis (Y-axis) tab on the left side and type in the Title: Incident Count.

7. Title the chart from the General tab as  Incident Count by Station Number for July 2019.

8. Click the Actions tab and set the filter targets to the Incidents layer of the map and to the Gauge (1) element.

9. Click the Done button.

10. Drag the new serial chart element below the map element.



Fire Response: Real-time and Analysis 

Copyright © 1995-2020 Esri. All rights reserved. 26 

11. Drag the border between the map and chart down to give more screen space to the map.

The overall dashboard layout should look similar to the following: 

12. Hover over the upper right corner of the new serial chart element and click on the button to expand it. This button is appears
on whichever element your mouse is hovered over.

Click the same icon to resume viewing the entire dashboard. 

13. Configure the Map (1) element.
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14. Click the Map Actions tab, add Serial Chart (1) and then clicking Done.

15. Save your dashboard.

16. In the upper left corner, click the button with Home followed by a downward pointing triangle and choose Content.

17. Within the ArcGIS Online Contents page, click the ellipsis associated with your Operations Dashboard app and choose View
Application.

18. Test out the functionality.  From the map, use the bookmarks to navigate the to Ewa, and turn on the visibility of fire stations
and incidents.  Click on different fire stations in the serial chart and watch the changes in response time.  Click on Station 40
in Kapolei and note the mapped distribution of incidents.  Even though Station 35 is located on Makakilo ridge, there was an
incident when Station 40 responded.  Response time might not have been critical because it was a “good will call”.  Clearly,
there are tweaks that could be made, but you have created the skeleton of an illustrative dashboard.
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